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Logging in to PowerTeacher

Note: If using Power Teacher on an instructional (student) computer, you will have to
save the Launch Gradebook file into your My Documents and then launch the file.

&

Open Internet Explorer

Enter the address

Newark Public Schools Home Page - Windows Internet Explorer

@._ v |£_ http:jsis.nps.k12.nj.usfteachers

https://sis.nps.k12.nj.us/teachers

in the browser address bar

z N Im —
1(A) Homeroom A & ™

Press Enter to open the login page

On the PowerTeacher login page, enter your network username and password

Press Enter to log in to the PowerTeacher Start Page

Taking Attendance

Navigate to Start Page > Chair icon
(next to the class for which you want to take
attendance)

Select the Date

ce | Thu g2

———

w

Record MultiMeeting Attendance for Multiple Sections

Homeroom - 1(A}
Current aftendance code: (P' esent)
. @

Brown, Jessica C

Select the Current attendance code

Click the cell next to a student’s name to assign that code

Click Submit

The green light next to the chair indicates that

your attendance has been submitted to PowerSchool.

Note: Even if all students are present, teachers
should click the Chair icon to open the
attendance screen, and then click Submit.

This tells PowerSchool that the teacher has taken

attendance.

1(A) Homaroom

6
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Adding Section Numbers to Class Names

on the Start page
If you teach more than one class with the same _
name, you can add section numbers to B PowerTeacher T
distinguish the classes on the Start page.
I ,s“fpﬂ'ii‘ Personalize - Orellano, Carmen

On the PowerTeacher Start Page, click o]
Personalize in the main menu on the left o
Click on the Display Section Number link
From the Display Section Number on the
PowerTeacher Home Page dropdown list,
select Yes

Mate: This setting will be effective the next time vou log into PowerTeacher,
Click Submit ¢

Note:

This change will not take effect until the next

time you log into PowerTeacher. Note the . B —
. ®: PowerTeacher B
section numbers have been added to the
ClaSS names. Sy Page | Current Classes
| o »
Meals WOLIMF]  World Language 230 j{‘
Personalize
Gk [P WOL(MF) Waorld Language 430 Sy
i k - ’&
- ] 14 La 0 >\
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Changing Class Names in the
Gradebook

If you teach more than one class with the same
name, you can change the way the names
appear in the Gradebook window, in the Classes
pane.

On the PowerTeacher Start Page, click the
arrow next to Gradebook

On the Tools menu, choose Preferences

Click on the Section tab, and choose Custom
Display Name

Click OK

In the Classes pane, select the class you wish to
rename

Click on the Class Content tab and make sure
that the Mode is Class Info

In the Custom Display Name box, type the name
of the class as you wish it to appear in your
Gradebook

Click Save
Note the new name in the Classes pane

Repeat for all other classes, starting with step 5
above

£ woL(m-F) wor
3 woL(M-F) wor
£ woL(m-F) wor
i woLm-F) wor
3 woL(m-F) wor
Bl woLM-F) Wor  crrr
i woL(M-F) wor
3 woLm-F) world

Copy Assignments

Preferences

Grading | Score Codes  Section | Spell Check | Standards | Student |

Choose the Identifier used to distinguish sections in the dlass list
(s Section Period Day
(" Section Number

Choose the Name used to distinguish sections in the class list

(" Course Name

Sort By:|Period/Day

n WA E) Sk rasernens §01% B3
L WOLIAED Word Lanpasie
) W) werld Lyrpoue

MM Wm mm s Contord,

E"H’@E

o ISR s,

sy Cenpent | (

) wounE) Word Lnpuce
£ W s world Lrgusie

£ wooer) word Langusge —I

Terooc 2010-2004
Stoets ORUERID Mha

Course Namne; 'Works Larossoe
Course Number! LUWLOZNYZ
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Printing a Class Attendance Roster

Navigate to Start Page > Printer icon (next to
the section for which you want to print reports)

Select the Class Attendance Audit report

Select whether to run a Test Print, if so, enter
the number of pages to print

Select the Watermark Text, if applicable
Select the Watermark Mode, if applicable
Select ASAP for when to print the report
Click Submit

On the Report Queue (System) — My Jobs
page,
e Click Refresh until the status is
Completed

e To open the report in a new window,
press & hold Ctrl while clicking View

1(A) Homaroom

which report vould you ke to pniX?
For which stpdents?

Test print?

Report Queue - My Jobs refresh

Created Job Name Started Ended Statue
08/12/2010 Class Attendance Audit  08/12/2010 11:40 AM  08/12/2010 11:40 AM W
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Setting Up Categories Based on NPS
Policy: Deleting, Adding, Editing

Whatever was set up in the previous year will
carry over to the current year.

Please VERIFY that it is correct.

Before you can create assignments, you must set
up categories. Categories are groups of the same
types of assignments. Categories are not class-
specific, eliminating the need to create the same
categories multiple times for each class.

On the PowerTeacher Start Page, click the arrow
next to Gradebook

On the PowerTeacher Gradebook page, click the
ScoreSheet tab

On ScoreSheet Tab, on the side bar, under the
Classes pane, verify your current classes.

PowerTeacher comes with existing Categories. To
customize PT Gradebook to meet the NPS Grading
Policy do the following:

Delete Categories

e On the side bar, under the Categories
pane, highlight Project, click the Minus
Sign below Categories to delete that
category. Click OK on the Delete
Categories window.

e On the side bar, under the Categories
pane, highlight Quiz, click the Minus
Sign below Categories to delete that
category. Click OK on the Delete
Categories window.

e On the side bar, under the Categories
pane, highlight Test, click the Minus
Sign below Categories to delete that
category. Click OK on the Delete
Categories window.

Note: Once a Category has had
assignments assigned to it, that category
can never be deleted, even in future
marking period and/or years. However, it is
not a problem to have a category with no
assignments ever assigned to it.

September, 2012

& Powerieacher 5
F 2 _ Cuvesrn Classes
sesees | e XE &
Lt e T & \ &, .=
2 Categories Ly
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Delete Categories . x|

Delete Categories

Are you sure you want to delete the selected Categories?

4 Cancel
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Add Categories

To add the Assessments category, on the
side bar, under the Categories pane highlight
ALL, then click the Plus Sign below
Categories. The Create Assignment
Category window will open. Fill in the
following fields:

Name: Assessment

Abbreviation: Assess

Color: Violet

Points Possible: 100

Extra Points: 0

Score Type: Percentage

Include in Final Grade: leave

checked

e Description: Assessments
category will count for 65% of
the final grade.

e Click OK

To add the Class Work and Participation
category, on the side bar, under the
Categories pane highlight ALL, then click the
Plus Sign below Categories. The Create
Assignment Category window will open. Fill
in the following fields:

e Name: Class Work and

Participation

Abbreviation: Class Wk/Particip

Color: Olive

Points Possible: 100

Extra Points: 0

Score Type: Percentage

Include in Final Grade: leave

checked

e Description: Class Work and
Participation category will count
for 25% of the final grade.

e Click OK

September, 2012

2

i

Create Assignment Category, =

3 Creste Assignment Category

Name: l»‘-;f/.v,mrl.',

Abbrevistion: l:.sf—oss

celoe: [T) ot > |

Theso optices will b appled a3 defauls to atvy Dew assiremonts when!

ceested foe ths category.

Pokws Possble: (100

Extra Poas: [0
Sooee Type: "m
Inchude in Fosl Grade: 7
Description:

Aasesaments category will coun

the final grade I

t fox 65% of
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x
Edit Categories M- E
To edit the Homework category, on the side e
bar, under the Categories pane, double click abbeavistion: §w
on the Homework category. The Create cobor: [ owe >
Assignment Category window will open. Fill mmwu&amw@msm
in the following fields: ' Pobes Possblos. 100
« Points Possible: 100 i
e Extra Points: 0  dadenFnd Gode:
® Score Type: Percentage Hom.euo::k category will count for 10% of the
¢ Include in Final Grade: leave final grade,
checked
e Description: Homework category
will count for 10% of the final
grade.
« Click OK e —

ﬁ] Assessments
{7 Class Work and Participation
f@ Homework

September, 2012 Page 7 of 53
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Secondary: Assign Category Weights
for Final Grades for Year Long
Classes

Category weighting calculates final grades
based on the weight of each category.

On the PowerTeacher Start Page, click the
arrow next to Gradebook

On the PowerTeacher Gradebook page, click
the Grade Setup tab

On the Side Bar, under the Classes pane,
click on the first year long class.

Under Reporting Term, double click on Q1.
(This will open the Q1 window.)

On the Q1 window, select Category Weights
Click on + Add Category

Select the following categories:
Assessment, Class Work and
Participation, Homework

Click OK

On the Q1 window, click on the zero in the
Weight column next to Assessments. Type
65, hit the Enter key

On the Q1 window, click on the zero in the
Weight column next to Class Work and
Participation. Type 25, hit the Enter key

On the Q1 window, click on the zero in the
Weight column next to Homework. Type 10,
hit the Enter key

Click Save

September, 2012

Efw\;u«

Sudent frfo | Geade Setup Class Cootent.

L“‘:E‘?’!"! _’E'L". _ ket 0.1
[V © 03612012 Thw 05281201371
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[ ]
iy 24 "
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=
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Secondary: Copy Category Weighting

to Other Quarters

[ Gomde Sy |
0 -
AL F

With the Q1 window open, click the Copy

Eu
button to copy. This will open the Copy Final -S4 s
Grade Setup window. e kst

Make sure Q1 Only is selected, then click
OK

On the Copy Grade Setup window, click Q2,
Q3, Q4, then click Next

A message window will open. Confirm that

Foomt D Lom

the selections are correct, then click Finish
a0 ctrgrs 24 mupmax =

Copy Final Grade Setup

Copy Final Grade Setup

f AN s >
thas reporting term o the entre ¢l

Select the Rem to be copied

) Entire clags - 1{A) Urdted States History 11

Copy Grade Sctop: 1(A) Unied States Hinteey N

Conpry G e Setuge 3{A) et SEACe4 Hintowy 11

Fate 0 G grade wnD 130 e Ilowng JA) Lnnd st Mobary Il repirteg bame

TN Pacireq Tem S Sea O buee Cvre 0
f [ ORI T OO Taaponns
B KN 2 T CHONNED P oty mNTes
UGHSIIH TGN oot

(a1 | 10 N R PR Y 0t oS

(¢ = l"_f‘.ﬂ ) CEORERAS Wt CREAGTS Y W2 200a pecs
[4 —._L_qb et wed Gt S wnd Sord powes

B ORI T ORI e Toed pores
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Secondary: Assign Category Weights
for Final Grades for Semester 1
Classes

Category weighting calculates final grades
based on the weight of each category.

On the PowerTeacher Start Page, click the
arrow next to Gradebook

On the PowerTeacher Gradebook page, click
the Grade Setup tab

On the Side Bar, under the Classes pane,
click on the first Semester 1 class

Under Reporting Term, double click on Q1.
(This will open the Q1 window)

On the Q1 window, select Category Weights
Click on + Add Category

Select the following categories:
Assessment, Class Work and
Participation, Homework

Click OK

On the Q1 window, click on the zero in the
Weight column next to Assessments. Type
65, hit the Enter key

On the Q1 window, click on the zero in the
Weight column next to Class Work and
Participation. Type 25, hit the Enter key

On the Q1 window, click on the zero in the
Weight column next to Homework. Type 10,
hit the Enter key

Click Save

September, 2012

oo Gt Bansl gr i wtvis
Tl pedn

£ Cotagary waighitn
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Secondary: Copy Category Weighting
for Semester 1 Classes to Other
Quarters

With the Q1 window open, click the Copy

D

Calodlate QI Fni grade vy | 00 |

button. This will open the Copy Final Grade 0 e =

Setup window. & Catmpry s

Make sure Q1 Only is selected, then click e N
On the Copy Grade Setup window, click Q2, Outicanmn 0 iimpat i

then click Next

A message window will open. Confirm that

the selections are correct, then click Finish

Copy Grade Selwp: 5(R) Soclokgy
Copy Grade Sctup: S5(R) Socklogy

Farstio the Q2 grvde sotip o the foliomary SUR) Saciiody rpinting tarms:
et A Ragoring Tem St Dbs _ErdDae Currect Sehp

1) NI TR ORORINI2 Ty Catngoey wsts.
2 DS 2007 Thy Caapony. sty
IR Ty SIS0 T TotH pores
LRIV Mo LRI Mon Cotngeey varights
CRRR013 Mo QRPALOL) Yo TN ports
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Secondary: Assign Category Weights
for Final Grades for Semester 2
Classes

Category weighting calculates final grades
based on the weight of each category.

On the PowerTeacher Start Page, click the
arrow next to Gradebook

On the PowerTeacher Gradebook page, click
the Grade Setup tab

On the Side Bar, under the Classes pane,
click on the first Semester 2 class.

Under Reporting Term, double click on Q3.
(This will open the Q3 window.)

On the Q3 window, select Category Weights
Click on + Add Category

Select the following categories:
Assessment, Class Work and
Participation, Homework

Click OK

On the Q3 window, click on the zero in the
Weight column next to Assessments. Type
65, hit the Enter key

On the Q3 window, click on the zero in the
Weight column next to Class Work and
Participation. Type 25, hit the Enter key

On the Q3 window, click on the zero in the
Weight column next to Homework. Type 10,
hit the Enter key

Click Save

September, 2012
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Secondary: Copy Category Weighting

for Semester 2 Classes to Other
Quarters

With the Q3 window open, click the Copy

button. This will open the Copy Final Grade

Setup window.

Make sure Q3 Only is selected, then click
OK

On the Copy Grade Setup window, click Q4,

then click Next

A message window will open. Confirm that
the selections are correct, then click Finish

September, 2012
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Secondary: Setting up Term Weights
for Final Grades for Year Long
Classes

Term weighting calculates final grades based
on the weight of each term.

On the PowerTeacher Start Page, click the
arrow next to Gradebook

On the PowerTeacher Gradebook page, click
the Grade Setup tab

On the Side Bar, under the Classes pane,
click on the first Year Long class.

Under Reporting Term, double click on F1.
(This will open the F1 window.)

On the F1 window, click Term Weights

Click on the 100 in the Weight column next
to Q1. Type 20, hit the Enter key

Click on the 100 in the Weight column next
to Q2. Type 20, hit the Enter key

Click on the100 in the Weight column next to
E1. Type 10, hit the Enter key

Click on the 100 in the Weight column next
to Q3. Type 20, hit the Enter key

Click on the 100 in the Weight column next
to Q4. Type 20, hit the Enter key

Click on the100 in the Weight column next to
E2. Type 10, hit the Enter key

Click Save

NOTE: This will also copy the Category
Weights set up in each of the quarters.

September, 2012
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Secondary: Copy Term Weights to
Other Year Long classes

With the F1 window open, click the Copy
button. This will open the Copy Final Grade
Setup window.

Make sure Entire Class is selected, then
click OK

Carefully select ONLY the Year Long
classes (NOT the Semester long classes)

Click Next

A message window will open. Confirm that
the selections are correct, then click Finish

September, 2012
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Secondary: Setting up Term Weights
for Final Grades for Semester 1
Classes

Term weighting calculates final grades based
on the weight of each term.

On the PowerTeacher Start Page, click the
arrow next to Gradebook

On the PowerTeacher Gradebook page, click
the Grade Setup tab

On the Side Bar, under the Classes pane,
click on the first Semester 1 class.

Under Reporting Term, double click on F1.
(This will open the F1 window.) i

On the F1 window, click Term Weights

Click on the 100 in the Weight column next
to Q1. Type 40, hit the Enter key

On the F1 window, click on the 100 in the
Weight column next to Q2. Type 40, hit the
Enter key

On the F1 window, click on the100 in the
Weight column next to E1. Type 10, hit the
Enter key

On the F1 window, click on the100 in the
Weight column next to E2. Type 10, hit the
Enter key

Click Save
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Secondary: Copy Term Weights to
Other Semester 1 Classes

With the F1 window open, click the Copy

Feapting Tren.

button. This will open the Copy Final Grade

Setup window. E o

Make sure Entire Class is selected, then b s ong &
click OK

Carefully select ONLY the Semester Long = |Cuamy
classes = ===

Click Next

A message window will open. Confirm that
the selections are correct, then click Finish

NOTE: This will also copy the Category
Weights set up in each of the quarters.
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Secondary: Setting up Term Weights
for Final Grades for Semester 2
Classes

Term weighting calculates final grades based
on the weight of each term.

On the PowerTeacher Start Page, click the
arrow next to Gradebook

On the PowerTeacher Gradebook page, click i m— o —
the Grade Setup tab e 3

gere

On the Side Bar, under the Classes pane,
click on the first Semester 2 class.

Under Reporting Term, double click on F1. -~ —i]
(This will open the F1 window.) WSS = )

On the F1 window, click Term Weights

gt it Cobp b

Click on the 100 in the Weight column next
to Q3. Type 40, hit the Enter key

On the F1 window, click on the 100 in the
Weight column next to Q4. Type 40, hit the
Enter key

On the F1 window, click on the100 in the
Weight column next to E1. Type 10, hit the
Enter key

On the F1 window, click on the100 in the
Weight column next to E2. Type 10, hit the
Enter key

Click Save
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Secondary: Copy Term Weights to
Other Semester 2 Classes

With the F1 window open, click the Copy
button. This will open the Copy Final Grade
Setup window.

Make sure Entire Class is selected, then
click OK

Carefully select ONLY the Semester 2
classes

Click Next

A message window will open. Confirm that
the selections are correct, then click Finish

NOTE: This will also copy the Category Weights set up in each of the quarters.
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Elementary: Assign Category
Weights for Final Grades for Year
Long Classes

Category weighting calculates final grades
based on the weight of each category.

On the PowerTeacher Start Page, click the
arrow next to Gradebook

On the PowerTeacher Gradebook page, click
the Grade Setup tab

On the Side Bar, under the Classes pane, click
on the first class, after Homeroom

Under Reporting Term, double click on Q1.
(This will open the Q1 window.)

On the Q1 window, select Category Weights
Click on + Add Category

Select the following categories: Assessment,
Class Work and Participation, Homework

Click OK

On the Q1 window, click on the zero in the
Weight column next to Assessments. Type
65, hit the Enter key

On the Q1 window, click on the zero in the
Weight column next to Class Work and
Participation. Type 25, hit the Enter key

On the Q1 window, click on the zero in the
Weight column next to Homework. Type 10,
hit the Enter key

Click Save
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Elementary: Copy Category
Weighting to Other

With the Q1 window open, click the Copy
button to copy. This will open the Copy Final
Grade Setup window.

Make sure Q1 Only is selected, then click OK

On the Copy Grade Setup window, click Q2,
Q3, Q4, then click Next

A message window open. Confirm that the
selections are correct, then click Finish
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Elementary: Setting up Term Weights
for Final Grades

Term weighting calculates final grades based
on the weight of each term.

On the PowerTeacher Start Page, click the E i‘;ﬁ \-';.'_, E
arrow next to Gradebook e gt i) % s EGMERASE R

On the PowerTeacher Gradebook page, click
the Setup tab

On the Side Bar, under the Classes pane,
click on the first class.

Under Reporting Term, double click on F1.
(This will open the F1 window.)

On the F1 window, click Term Weights
On the F1 window, click on the 100 in the

Caloulate 71 Sowl geade uvieny

™ Total points Ny of Jou soaves bo disrivd
Weight column next to Q1. Type 25, hit the @ Tom weights
Enter key ST —
e [ wegt| Peeert [l |
On the F1 window, click on the 100 in the . S
Weight column next to Q2. Type 25, hit the Go =
Enter key - S

On the F1 window, click on the100 in the

Weight column next to Q3. Type 25, hit the
Enter key

On the F1 window, click on the100 in the
Weight column next to Q4. Type 25, hit the
Enter key

Click Save
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Elementary: Copy Term Weights to [}
Other Classes
With the F1 window open, click the Copy .
button. This will open the Copy Final Grade ok L A
Setup window ' G MR
Make sure Entire Class is selected, then o] ama |F < s
click OK M & Surmnaoie ’ "
Carefully select ALL other classes EXCEPT — ) 1T
Homeroom and Lunch [ ba il
Click Next =
A message window will open. Confirm that £
the selections are correct, then click Finish g s Ve v
A Faste the MATOM-F) Mothematics frud orvde ssbp o the follorng daspan:
S — £
NOTE: This will also copy the Category | e R
Weights set up in each of the quarters. P Gesunesee
i+ £ weiee) wizng
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Create Assignments

Assignments can be created one at a time as
you progress through the term, or they can be
set up for the entire term before the term starts.

On the PowerTeacher Start Page, click the
arrow next to Gradebook

On the PowerTeacher Gradebook page, click
the Assignments tab

On the Side Bar, under the Classes pane, click
on the class for which you wish to create
assignments

Click the Assignments tab

Click the Plus sign on the bottom of the
Assignments window. This will open the New
Assignment window.

In the New Assignment window, fill in the
following fields:

e Name
e Category

e Date Due (date should be in the date
range of the marking cycle)

o Description

Confirm the information in the following fields:

Score type is Percentage

Points Possible is 100

Extra Points is 0

Weight is 1.00

Include in Final Grade is checked
Click Save

(See Notes on next page.)

September, 2012
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Note:

To give an Assignment more weight, change
the Weight field to a higher number. (Ex: If a
chapter test is weighted twice as much as a
quiz, change the Weight field from 1.0 to 2.0).

To change the Publish date on the assignment,
click the Publish tab on the New Assignment

window. Select when to publish the assignment.

September, 2012
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Edit Assignments

T S =1
Edit assignments if changes need to be made S
to the information attached to a particular
assignment. 9
On the PowerTeacher Start Page, click the
arrow next to Gradebook
On the PowerTeacher Gradebook page, click
the Assignments tab . [
On the Side Bar, under the Classes pane, click - ,__ﬂ R 9
on the class for which you wish to edit e N—
assignments ' i il s
[y yw— i Someton fromy o]
Double click the assignment to edit rebatle T b E ey e fE
tded e Ik eSed e
Make the appropriate changes oo R T
Click Save
[ e
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Copy Assignments

Use the Copy Assignments function to copy
assignments from one class to other classes.

On the PowerTeacher Start Page, click the
arrow next to Gradebook

On the PowerTeacher Gradebook page, click
the Assignments tab

On the Side Bar, under the Classes pane,
click on the class from which you wish to copy
assignments

On the Menu Bar, click Tools, select Copy
Assignments. This will open the Copy
Assignments window.

Select the assignment(s) to be copied
Click Next

Select the class(es) to copy to

Click OK

Copy Assignments from one year to another

Change to the year you want to copy the
assignment(s) from.

On the Side Bar, under the Classes pane,
click on the class from which you wish to
copy assignments

On the Menu Bar, click Tools, select Copy
Assignments. This will open the Copy
Assignments window

Select the assignment(s) to be copied
Click Next

Select the year/term to copy to
Select the class(es) to copy to

Click OK
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Delete Assignments

Assignments can be deleted. If an assignment 2 —
does not have scores, the Delete Assignment LR E . s B e
window states, "Are you sure you want to {52 @’ \;’9 B =
delete Assignment [name]?" | Seebow | wsqesti Sobetify Godseup ChusCotat  fepots
Repoetng Speme ;g! L]

If an assignment has scores, the Delete -

i _ o _ Have ¥R CHegxy  OoetsPusste  Wek Dt L
Assignment window states, "This assignment ' ' 3 ] TR
Capter 1 Qe O Ot "{/ Rogasira. . 10 L2 51 H010 Mo
has scores. Are you sure you want to delete
assignment [name] and all associated scores?"
k3
On the PowerTeacher Start Page, click the —

arrow next to Gradebook

At you sre vou e bo delete Assorment: Chapter 2 Qutr
On the PowerTeacher Gradebook page, click & E

the Assignments tab

On the Side Bar, under the Classes pane, -
click on the class from which you wish to —

delete assignments
Highlight the assignment to delete

Click the Minus sign on the bottom of the
Assignment window

A message window will open. Confirm the
deletion, then click Yes
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Entering Scores for Assignments

Student scores, for assignments, can be entered
from the ScoreSheet window or Score Inspector.

On the PowerTeacher Start Page, click the
arrow next to Gradebook

On the PowerTeacher Gradebook page, click ‘
the ScoreSheet tab

On the Score Sheet tab, on the Side Bair, B
under the Classes pane, click on the class for , 30
which you wish to enter scores o %g
Click in the cell to enter scores g8z
5% Bl s %
B o] we W
: e | we %
] ) ) rwn . O 2% dh| s% 0 m%
Note: Right mouse click on the assignment to Gt QDY 8% | Bs oW
. ) sty OB 5% Mo n%
access a drop down menu of options or click on ot OB ] e B
the Menu Bar, select Tools to access the ... g: : i A
options below: <l g
dbess QK 9% COYIEE
e Score Inspector: to attach a comment K, O 6 LR

to a score or mark it late, missing, etc.

e Fill Scores: to mass fill scores

Chapler 3 Ouaz
10871312010

)
Chapter 2 Quiz

£ 5P -
{ 5% % o | % % g
w5 o | o

e, E... % s 5% L e —
Caboat... &% als 7% 2% FllSoes
Db, &% o Wh TR kAl »
Fonees, ... s 0 I T . P
Osaaed... O 8 % | oms s  SeotEomlech
e I % Na | e ook CerSones
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Individual Student Report

Run the Individual Student Report to
generate class scores by assignment, and the
final grade for each reporting term, listed in a
one page per student layout.

On the PowerTeacher Start Page, click the
arrow next to Gradebook

On the PowerTeacher Gradebook page, click
the Reports tab

On the side bar, under the Classes pane,
highlight the class for which you wish to print
reports.

On the side bar, under the Student Groups
pane, double click Active. This will open a
list of students assigned to that class.

To select certain students, hold the Ctrl key
and highlight the names or do not highlight
any names to print the entire class.

On the Reports page, double click
Individual Student Report. This will open
the Individual Student Report window.

On the Individual Student Report window,
click the Criteria tab. Fill in the following
information:

e Output Type: PDF
e Sections: Selected Class

e Student: All Enrolled will print the
entire class. Selected Groups and/or
Students will print the students you
selected

e Student Field: Student Name

e Abbreviate: Leave Assignments and
Categories blank

¢ Include: check Final Grades,
Assignments, Comments, Categories
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e Date Range: Click the down arrow to
select the cycle to print

On the Individual Student Reports window,
click the Layout tab. Fill in the following
information:

¢ Report Title: Give the report a title
o Page Break: check On Students

e Top Note: check Include and Bold to
type a note you wish to print on the top
of the report.

e Bottom Note: check Include and Bold
to type a note you wish to print on the
bottom of the report.

e Signature Line: check Include

Click Run Report

At the Report Complete window select Save
Report to save an electronic copy of the
report. Select Open Report to open and
print the report.
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Entering Comments for Progress
Reports

Comments can be entered from the ScoreSheet
window using the Score Inspector.

On the PowerTeacher Start Page, click the
arrow next to Gradebook

On the PowerTeacher Gradebook page, click
the ScoreSheet tab

On the Score Sheet tab, on the Side Bar,
under the Classes pane, click on the class for
which you wish to enter comments

Make sure that the Reporting Term is set to
the correct Cycle

Highlight the student’s name, then right-click in
the cell under the Final Grade column and
choose Show Score Inspector

Note that the Student and Reporting Term
are correct

You may enter a narrative comment in the
comment box
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You may also choose comments from the bank
of comments on the Comment tab

Click the comment you wish to choose, then
click the Insert Selected button

The comment(s) you choose will be placed in
the Comment box

If you wish to enter comment(s) for more
students, simply use the arrow to the right of
the student’s name to navigate to the next
student Above or Below in your class list

Click Close when you are done entering
comments for all students

Note:

e After you have clicked Close, note the
little blue C in the Final Grade column.
You can view the comments by using your
mouse to point to the little blue C.

*Any comments entered for the
progress reports, if not changed or
removed will affect what is printed on
the report cards.
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Print Progress Reports or Report Cards in

PowerTeacher % PowerTeacher
Progress Reports and Report Cards can be printed for b [E—
1 student, 1 class or all the students you teach. et T

To print for 1 student: | ekl T

4(;;
On the PowerTeacher Start Page, click the
Backpack for the class in which the student is a
member

In the left pane click the name of the student

From the dropdown list on the upper right choose : Student information
Print a Report o SRS ey

On the Print a Report screen, from the drop down
select the report you wish to print

To insert a Watermark, choose Custom from the
dropdown, type in NPS in the box below

Choose When to Print il i .

Click Submit — this will take you to the Report : o
Queue ~ .

See Instructions on How to View Reports on the
Report Queue

Print A Report [Sdect o]
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Print a Progress Report or Report Card for
1 Class

On the PowerTeacher Start Page, click the Printer
icon for the class for which you wish to print either
Progress Reports or Report Cards

On the Print Class Reports screen, from the drop
down select the report you wish to print

If you wish to run a Test print, you can check the
check box and indicate the number of pages you
wish to print

To insert a Watermark, choose Custom from the
dropdown, type in NPS in the box below

Choose When to Print

Click Submit — this will take you to the Report
Queue

See Instructions on How to View Reports on the
Report Queue
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Print a Progress Report or Report Card for
All the Students You Teach

On the PowerTeacher Start Page, on the Main
Menu on the left, click Reports

On the Reports for All Students screen, from the —

. . Regorts for All Students
drop down select the report you wish to print e
If you wish to run a Test print, you can check the S
check box and indicate the number of pages you ot
wish to print resnosrtrn | —

To insert a Watermark, choose Custom from the B iy
dropdown, type in NPS in the box below ]

Choose When to Print

Click Submit — this will take you to the Report
Queue

See Instructions on How to View Reports on the
Report Queue
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View Reports on the Report Queue

Reports remain on the Report Queue for 90 days or
until you delete them. They are listed in order on the
report queue from the most recent on the top to the
oldest on the bottom of the list.

On the PowerTeacher Start Page, click the paper
icon to the left of the Logout button. This opens the
Report Queue window. If you have just submitted a
report, you will automatically be taken to the Report
Queue window

The Status may say Pending, Running or
Completed. You may not view nor print the report
until the Status says Completed. You can keep
clicking the Refresh link next to My Jobs until the
Status is Completed or you can go and do other
work and check back to the Report Queue later

When the Status says Completed, right-click on the
View link to Open in New Tab

Note:

To delete reports that you no longer need from the
Report Queue, simply click the trash can icon next to
the report you wish to delete. Be advised that you will
not be warned — the report will just be deleted!
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End of Cycle — Grades K-8 Entering Subject
Skills and 21° Century Skills

At the end of each Cycle enter the skills marks for all
subject skills and 21% Century Life Skills.

On the PowerTeacher Start Page, click the arrow next
to Gradebook

On the PowerTeacher Gradebook page, click the
ScoreSheet tab

On the Score Sheet tab, on the Side Bar, under the =——— E [ % E 3
Classes pane, click on the class for which you wish to | e il ¥ i B p L
enter skill marks | o Ay Sdtih ke Gt

ity s DR~ e
=" i) ! ~ - S

[.i:{':qu
Click the Final Grades button § oo s &
ﬁ‘i’ﬁmz

ez |
§

i ‘

Highlight the student’s name, then right mouse click
in the cell of the skill. A drop down menu will open.
Select Grades to access the options below:

+ Exceeds grade level expectations

*  Meets grade level expectations
- Does not meet grade level expectations

/ Not assessed at this time

Click Save
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End of Cycle - Comments

Elementary Report Cards

Comments: ability to write a narrative- Grades K-5

only

Grades K-5 Homeroom teachers will write a
narrative in the comment box (Maximum of
1,000 characters) for their students instead of
selecting a comment code for each of the
subjects taught by the homeroom teacher.

The Homeroom teacher will enter the narrative
in the 21° Century Life and Career Skills
course in the comment box. (See the section
on Entering Comments for Progress Reports for
directions on how to enter a narrative
comment.)

All non- core teachers will select one NPS
comment code from the drop down selection for
their courses. Or if the teacher wants to select
two comments they must type in the code #s
separated by a comma. Ex. 01,03

Grade 6-8 teachers will select one NPS
comment code from the drop down selection for
their courses. Or if the teacher wants to select
two comments they must type in the code #s
separated by a comma. Ex. 01,03

September, 2012
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End of Cycle — Grades 6-12

Final grades and comments must be verified
by teachers BEFORE grades are stored for
printing on report cards.

On the PowerTeacher Start Page, click the
arrow next to Gradebook

On the PowerTeacher Gradebook page, click
the Reports tab

With the Reports tab selected, on the Side
Bar, under the Classes pane, click on the
class for which you wish to verify grades

Under Name, double-click on Final Grade
and Comment Verification. This will open
up a pane below

On the Criteria tab choose the following:

Output Type: PDF
Sections: Selected Class

Students: All Enrolled (includes active &
inactive students)

Student Field: Student Name
Include: Course Grade

Check Grade and Comment check boxes,
only

Choose the appropriate Cycle from the
Reporting Term dropdown

On the Layout tab, check the check box to
Include a Signature Line

Click Run Report

Click Open to open and view the report on
your screen or click Save to save the report
wherever you choose.

Note: Carefully review the Final Grade and
Comments for each student. If there are any
errors, go back to your Scoresheet tab in the
Gradebook to make changes. After making all
corrections, rerun the Final Grade and
Comment Verification report, sign and date,
and submit to your administrator.
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End of Cycle — Grades K-5

Final grades and standards must be verified by
teachers BEFORE grades are stored for
printing on report cards.

On the PowerTeacher Start Page, click the
arrow next to Gradebook

On the PowerTeacher Gradebook page, click
the Reports tab

With the Reports tab selected, on the Side
Bar, under the Classes pane, click on the PRRP— s A ety
class for which you wish to verify grades and R —— it e, S
standards — onmee

Under Name, double-click on Standards ’ —
Report. This will open up a pane below .

On the Criteria tab choose the following:

Report Layout: Class Spreadsheet

Output Type: PDF
Sections: Selected Class

Students: All Enrolled (includes active &
inactive students)

Student Field: Student Name
Include: Standard Name
Check Overall Section Grade check box only 20 i pae

Choose the appropriate Cycle from the
Reporting Term dropdown @ rope e P

On the Layout tab, check the check box to = 2 S
Include a Signature Line : S =

Click Run Report ‘

Click Open to open and view the report on e el
your screen or click Save to save the report ‘
wherever you choose.

Note: Carefully review the Final Grade and
Standards for each student. If there are any
errors, go back to your Scoresheet tab in the
Gradebook to make changes. After making all
corrections, rerun the Standards report, sign
and date, and submit to your administrator.
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Final Grade and Comment
Verification Report

Verify final grades and standards for active
students BEFORE grades are stored in Power
School and printed on report cards.

On the PowerTeacher Start Page, click the
arrow next to Gradebook

On the PowerTeacher Gradebook page,
click the Reports tab

With the Reports tab selected, on the Side
Bar, under the Classes pane, click on the
class for which you wish to verify grades and
standards

On the Side Bar, under the Student
Groups, click on Active

Under Name, double-click on Final Grade
and Comment Verification. This will open
up a pane below

On the Criteria tab choose the following:
Report Layout: Class Spreadsheet

Output Type: PDF
Sections: Selected Class

Students: Selected Groups and/or Students
(includes only active students)

Student Field: Student Name
Include: Course Grade
Check Grade and Comment box

Choose the appropriate Cycle from the
Reporting Term dropdown

On the Layout tab, check the check box to
Include a Signature Line

Click Run Report

Click Open to open and view the report on
your screen or click Save to save the report
wherever you choose.
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Entering Mid-Term & Final Grades
For S1 Semester-Long Classes

You must have already completed the correct
Grade Setup based on NPS guidelines, i.e.,
for S1 semester-long classes, the F1 final
grade will be 40% of Q1, 40% of Q2,10% of E1
and 10% of E2. .

Entering Mid-Term Grade

In the Gradebook, select the S1 semester-
long class.

Navigate to the Assignments tab. Insure
that the Reporting Term is set to E1.

Click the plus sign at the bottom of the
Assignments window to create a new
assignment. This will open a new window
below.

Enter the following values:
Name: Mid-Term Exam
Abbreviation: Mid-Term Exam
Category: Assessments
Score Type: Percentage
Points Possible: 100
Weight: 1.0
Date Due: 11/15/2012 or 11/16/2012
Include in Final Grade: Must be checked

Description: The Mid-Term Exam will
count for 10% of the final grade for
semester long classes.

Click Save
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The procedure for entering the final exam
grade is very similar as follows:

Entering Final Exam Grade

In the Gradebook, select the S1 semester-
long class.

Navigate to the Assignments tab. Insure
that the Reporting Term is set to E2.

Click the plus sign at the bottom of the
Assignments window to create a new
assignment. This will open a new window
below. (Do NOT simply change the contents
in the window below — this would edit the
Mid-Term exam criteria — you MUST click
the plus sign to enter a new assignment for
the final exam grade)

Enter the following values:
Name: Final Exam
Abbreviation: Final Exam
Category: Assessments
Score Type: Percentage
Points Possible: 100
Weight: 1.0
Date Due: 2/4/2012 or 2/5/2012
Include in Final Grade: Must be checked

Description: The Final Exam will count
for 10% of the final grade for semester
long classes.

Click Save
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Entering Mid-Term & Final Grades
For S2 Semester-Long Classes

You must have already completed the correct
Grade Setup based on NPS guidelines, i.e.,
for S2 semester-long classes, the F1 final
grade will be 40% of Q3, 40% of Q4,10% of E1
and 10% of E2.of E2.

Entering Mid-Term Grade

In the Gradebook, select the S2 semester-
long class.

Navigate to the Assignments tab. Insure
that the Reporting Term is set to E1.

Click the plus sign at the bottom of the
Assignments window to create a new
assignment. This will open a new window
below.

Enter the following values:
Name: Mid-Term Exam
Abbreviation: Mid-Term Exam
Category: Assessments
Score Type: Percentage
Points Possible: 100
Weight: 1.0
Date Due: 4/22/2013 or 4/23/2013
Include in Final Grade: Must be checked

Description: The Mid-Term Exam will
count for 10% of the final grade for
semester long classes.

Click Save

The procedure for entering the final exam
grade is very similar as follows:
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Entering Final Exam Grade

In the Gradebook, select the S2 semester-
long class.

Navigate to the Assignments tab. Insure
that the Reporting Term is set to E2.

Click the plus sign at the bottom of the
Assignments window to create a new
assignment. This will open a new window
below. (Do NOT simply change the contents in
the window below — this would edit the Mid-
Term exam criteria — you MUST click the plus
sign to enter a new assignment for the final
exam grade)

Enter the following values:
Name: Final Exam
Abbreviation: Final Exam
Category: Assessments

Score Type: Percentage

[
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N Asoppment.

Points Possible: 100 - = ST R
Weight: 1.0 % et ke
Date Due: 6/27/2013 or 6/28/2013 e T T
Include in Final Grade: Must be checked
Description: The Final Exam will count
for 10% of the final grade for semester
long classes.
Click Save
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Entering Mid-Term & Final Grades
For Year-Long Classes

You must have already completed the correct
Grade Setup based on NPS guidelines, i.e.,
for year-long classes, the F1 final grade will be
20% of Q1, 20% of Q2. 20% of Q3, 20% of
Q4, 10% of E1 and 10% of E2.

Entering Mid-Term Grade

Navigate to the Assignments tab. Insure
that the Reporting Term is set to E1.

Click the plus sign at the bottom of the
Assignments window to create a new
assignment. This will open a new window
below.

Enter the following values:
Name: Mid-Term Exam
Abbreviation: Mid-Term Exam
Category: Assessments
Score Type: Percentage
Points Possible: 100
Weight: 1.0
Date Due: 2/4/2013 or 2/5/2013
Include in Final Grade: Must be checked

Description: The Mid-Term Exam will
count for 10% of the final grade for year
long classes.

Click Save

The procedure for entering the final exam
grade is very similar as follows:

il YO

| G feoyeuts RSt Ga o Omilevst  Feets

In the Gradebook, select the year-long class.
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Entering Final Exam Grade

Navigate to the Assignments tab. Insure
that the Reporting Term is set to E2.

Click the plus sign at the bottom of the
Assignments window to create a new
assignment. This will open a new window
below. (Do NOT simply change the contents
in the window below — this would edit the
Mid-Term exam criteria — you MUST click
the plus sign to enter a new assignment for
the final exam grade)

Enter the following values:
Name: Final Exam
Abbreviation: Final Exam
Category: Assessments
Score Type: Percentage
Points Possible: 100
Weight: 1.0
Date Due: 6/27/2013 or 6/28/2013

Include in Final Grade: Must be checked

10% of the final grade for year long
classes.

Click Save

In the Gradebook, select the year-long class.

Description: The Final Exam will count for
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Elementary: Copying Grade Setup to
New Sections

Grade setup for all new sections must be
copied from the grade setup for existing

sections in order for the final grade to be
calculated correctly. SR o

Select an existing section already having the e
correct Grade Setup as per the NPS criteria. | | |7 ===

Select the Grade Setup tab.

Verify that for each cycle (Q1, Q2, Q3, Q4),
Category Weights are set to be 65% for
Assessments, 25% for Class Work &
Participation, and 10% for Homework.

Also verify that for F1, Term Weights are set
to be 25% for Q1, 25% for Q2, 25% for Q3
and 25% for Q4.

NOTE: If you have not already completed
grade setup for any existing sections as per

NPS criteria, see the PowerTeacher & - =33 BT o
Gradebook manual for instructions on ae a
Elementary: Assign Category Weights o

for Final Grades, and Elementary: Assign
Term Weights for Final Grades.

Copy Final Grade Setup I x|

In the Grade Setup tab for the existing Copy Final Grade Setup
section with the correct Grade Setup, double- Copy thés reporting tevm oF k¥
click on F1 under Reporting Term. Click the
Copy button in the lower window.

Select the item to be copied
(" FL oy (gt Avaishls C,:‘. Terrn W eintay
(¢ Entire class - ROG(M-F) Reading

The Copy Final Grade Setup window opens. QY
Verify that Entire class is the option selected.

Click OK. =
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The Copy Grade Setup window opens.
Choose the new section or sections, for
which you wish to copy the grade setup.
Click Next. Verify the information on the
next window and click Finish.

The grade setup for F1 as well as for all 4
cycles, Q1, Q2, Q3, and Q4 has been
successfully copied to all new sections.
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Copying Q1 Final Grade for Dropped
Students

Students who have been dropped from one
section and moved to another section must
have their final grade manually copied from Q1
in the old section to Q1 in the new section.
This must be done before the end of the
year to ensure that the student’s final grade for
F1 is calculated correctly.

Select the old section from which students
have been dropped. Under Student Groups
on the left, double-click on the Dropped
folder. The dropped students will be
displayed below in gray.

Navigate to the Reports tab. Under Name,
double-click on Scoresheet. This will open a
window below.

Choose the following options on the Criteria
tab:

Students: Selected Groups and/or
Students

Items to Include: check Final Grades and
choose Q1 from the dropdown list

Date Range: Q1
All other default options are correct.
Click Run Report.

The Scoresheet report will show the final
grade for each of these students for Q1. Now
these grades must be manually copied as
follows.

I‘y RDG(M-F) Reading
L wRI(M-F) writing
L SOC(M-F) Social Studies
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e T E L4
; £ P0G E) Reatens Lo &
Navigate to the Scoresheet tab. Select the (4 w1 ) wiking || oemeor | Aespments Shodntits,
new section to which the students have (8 20C08) Socf Sodes | Repering e a1 =]
. s B0 ROGOWF) Reading 222 i
been moved. Notice that now the students 5 wespw ) wreeg 222 A— - 5
names are listed in the Scoresheet as they {§ 5008F) Soad Sudes | |Lnieme, ' =
Active in the new section e S S——
are AcCtive In . [;l-vmwu:.wmg __[:' deeis (7) @) rinslGrode

For the Reporting Term, choose Q1 from the -
dropdown list. Notice there are no final
grades for these students for Q1 as they
were not active in this section for Q1. Their
final grades for Q1 must be manually
input.

0000000
2
-

afs

In the (Q1) Final Grade column, right-click

on the first student row, and choose Show X|

Score Inspector from the shortcut menu.
. Student: Julia Green E
Verify the Student and make sure the 3
Reporting Term specifies Q1. Check the RRpoing 160, Q)
Manual Override box. Type in the Percent
and choose the letter Grade from the

dropdown list as was indicated on the

Scoresheet report.

Use the down arrow to the right of the
student’s name to navigate to the next
student. Follow the same procedure for each Comeant:
of the students whose grades must be [
manually input.

When finished with all students, click Close B s )
to close the Score Inspector window. e E
Click Save in the Gradebook window. | Scorsshent e S Y S AN e ke
Reporteg T m:rQZ ) ey
Nl ©°4d ©.
| Gzinr | (] = §
VERY IMPORTANT! Please make sure to SRR iz |3z
change the Reporting Term back to the . . s 325 320
. Students (7) (Q2) Finai Grade odE g% 12
current cycle in the Scoresheet tab. oty i > g S
Meding, Natasha & nja
Morralvo, Michael O aiz
Pagan, Anoe < nfa
Reece, Niesha <> afa
Soto, Jonathasn () nfa
Wikams, Alea =+ nfs
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Accessing Q2 Data for Dropped
Students

In the PowerTeacher Gradebook, select the
class the students had been enrolled in

originally, from which you wish to retrieve W — LS
data. On the Scoresheet tab, you will not £ 520002 I Ed ""§§u i,
see these students’ names as it only displays ;# Py e L i
those students who are currently active in the e e —

class. s 5

On the left-hand side under Student Groups,
double-click on the Dropped folder. You will
see a number in parentheses next to the
word Dropped. This indicates how many
students have been dropped from this class.
These students will be listed below the
Dropped folder in gray.

Navigate to the Reports tab. Under Name,
double-click on Scoresheet. This will open a
window below. On the Criteria tab next to
Students, select the option for Selected
Groups and/or Students. Next to Date
Range, select the option for Q2. All other
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£ 22cpre) saateq -1 -
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default options selected are correct. e’/ e S s
C“Ck Run Report R Wit Tid .-zj.a-u-. " “"-T:’f"
The report generated will display all e BT L P
assignment and grading information you had e S

already entered for these students. The
assignments may be copied from the old
section to the new section. Only the grades _ )
must now be manually input for these f‘,"q@ s
students in the correct section where these

s 8

B

i

) weana) weng

1 < 07#) Socl Rudes T oemeotemfar %] Mo m
students are now active. Print the report for e mana DU © ;¢
your reference. [ esnmons | SO T

_ 8 v o g %"i
Navigate to the Scoresheet tab. See the de—ul 2lewih TS - ] :
PowerTeacher Gradebook manual for tigihownseons  sjfesanie O o
instructions on how to Copy Assignments. > iowm ,',:W“,::“ *

Select the new section where the moved
students are now located. Now proceed to
manually enter grades for the students.
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